Unit 7: Database Development (Basic)
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UNIT-7

SESSION 1: DATABASE CONCEPTS
Relevant Knowledge
A database is an organized collection of data. You can visualize it as a container of information.
The data is typically organized to model relevant aspects of reality (for example, the availability of
rooms in hotels), in a way that supports processes requiring this information (for example, ﬁnding
a hotel with vacancies).
Suppose if you own a stationary shop, you need to keep detailed records of the materials available
in your shop. You also need to store information about pricing, stock levels for reordering, old
stocks, etc. While in the manual system, you would maintain several ﬁles with different bits of
information; in the computerized system you would use database programs such as Microsoft
Access, OpenOfﬁce.org Base, and MySQL, to organize the data as per your business need.
The database concept has evolved since the 1960s to ease increasing difﬁculties in designing,
building, and maintaining complex information systems (typically with many concurrent end-users,
and with a large amount of diverse data).
In this lesson, you will learn database concepts and to work with a Database Management System
(DBMS).

Database Management System
A database management system is a software package with computer programs that controls the
creation, maintenance, and use of a database. It allows organizations to conveniently develop
databases for various applications. A database is an integrated collection of data records, ﬁles,
and other objects. A DBMS allows different user application programs to concurrently access the
same database.
Well known DBMSs include Oracle, IBM DB2, Microsoft SQL Server, Microsoft Access, PostgreSQL,
MySQL, FoxPro, and SQLite.
Data can be organized into two types:
•

Flat File: Data is stored in a single table. Usually suitable for less amount of data.

•

Relational: Data is stored in multiple tables and the tables are linked using a common ﬁeld.
Relational is suitable for medium to large amount of data.

Database Servers
Database servers are dedicated computers that hold the actual databases and run only the
DBMS and related software. Typically databases available on the database servers are accessed
through command line or graphic user interface tools referred to as Frontends; database servers
are referred to as Back-ends. Such type of data access is referred to as a client-server model.
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RDBMS
A relational database management system (RDBMS) is a database management system that is
based on the relational model as introduced by E. F. Codd, of IBM’s San Jose Research Laboratory.
Most popular databases currently in use are based on the relational database model.
The relational model for database management is a database model based on ﬁrst-order predicate
logic, ﬁrst formulated and proposed in 1969 by Edgar F. Codd. In the relational model of a database,
all data is represented in terms of tuples, grouped into relations. A database organized in terms of
the relational model is a relational database.
The purpose of the relational model is to provide a declarative method for specifying data and
queries: users directly state what information the database contains and what information they
want from it, and let the database management system software take care of describing data
structures for storing the data and retrieval procedures for answering queries.

Database Concepts
Database contains objects that are used for storing and managing information. To understand
a database in very simple language, let’s look at the example of your address book. What do
you store in an address book? You may have people’s name, people’s address, people’s phone
number and maybe even people’s birthdays. There is a common element here – people. In this
example, each person is considered an “item”. So, an item is what the database is storing
information about. When you were recording information in your address book, what did you ask
the people? What is your address? What is your phone number? etc. Each question that we ask
about our item is a “ﬁeld”. Now, say you make new friends and want to add their information
to your address book. You will ask questions, get the answers and create a new “record”. So a
record is a set of information (made up of ﬁelds) stored in your database about one of the items. A
“value” is the actual text or numerical amount or date that you put in while adding information to
your database. When you put all the information together in a grid (like you do in a spreadsheet),
a collection of similar records creates a table.

A database can have one or many tables. An address book example is a very simple one, in real
life there are many more details involved. A big company would have in its database, one table for
its products, one table for its suppliers, one table for its customer details, one for orders received
and maybe many others. Basically each table in a database contains information about one type
of item. So a database is basically a container that holds tables and other objects and manages
how they can be used.
Another very important thing to remember is that when we put in information, we may have people
with the same name (there can be more than one Charu Arora) or the same address (members
of a family). But when creating a database an important feature is record uniqueness in every
table. It is important to be able to distinguish between different items having duplicate values.
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Uniqueness helps to avoid accidental duplication of records caused by user or computer error. This
can be achieved by using some number or value that uniquely identiﬁes a record. If such a unique
value does not exist in your ﬁelds, as the database designer, you can create a special additional
ﬁeld in a table where unique numbers or values can be assigned for each new entry. Therefore,
every table has a key ﬁeld which ensures that there are 100% unique values throughout the
database.
Every database table should have one or more ﬁelds designated as key. You can assign a unique
value to this key for differentiating records that may have similar names or address. Look at the
following example of student database:
Name

Standard

Section

Ram

X

A

Ravi

X

A

Ravi

X

A

Sanjay

X

B

In this table, it will be extremely difﬁcult to differentiate between student records as they have
names that are similar. To differentiate, you can add additional ﬁeld - roll number - that will be
unique for each record (example below).
Rollno

Name

Standard

Section

19

Ram

X

A

20

Ravi

X

A

21

Ravi

X

A

22

Sanjay

X

B

EXERCISE
Perform the following activities till you are conﬁdent:
S.No.
1.

2.
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Activities
Analyze database requirements for a retail shop. Record the business requirements
and document. (You can use this information for creating a database to suit this
business requirement)
Analyze database requirement for your school; visit different departments such as
library, student admission centre, to gather requirements. Document the business
requirement. (You can use this information for creating a database to suit this
requirement
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ASSESSMENT
Short Answer Questions
1.

What does DBMS stands for?

2.

What does RDBMS stands for?

3.

How is data organized in a RDBMS?

Fill in the blanks:
1.

A

is an organized collection of data.

2.

A
databases.

3.

A
relational model.

4.

Three popular DBMS software are
.

is a software package that can be used for creating and managing

is a database management system that is based on the

,

, &

SESSION 2: DATA STORAGE
Relevant Knowledge
Data in a relational database management system (RDBMS) is organized in the form of tables.
You will now quickly recap what you learnt in the last session and assimilate more concepts.

Tables:
A table is a set of data elements (values) that is organized using a model of vertical columns
(which are identiﬁed by their name) and horizontal rows. A table has a deﬁned number of columns,
but can have any number of rows. Each row is identiﬁed by the values appearing in a particular
column identiﬁed as a unique key index or the key ﬁeld.

Columns or Fields:
A column is a set of data values of a particular simple type, one for each row of the table.
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The columns provide the structure according to which the rows are composed. For example,
cFirstName, or cLastName are ﬁelds in a row.

Rows or Records or Tuples:
A row also called a record or tuple represents a single, data item in a table. In simple terms, a
database table can be visualized as consisting of rows and columns or ﬁelds. Each row in a table
represents a set of related data, and every row in the table has the same structure.

Data types:
Datatypes are used to identify which type of data (value) we are going to store in the database.
Fields themselves can be of different types depending on the data they contain. Data types in
OpenOfﬁce base is broadly classiﬁed into ﬁve categories listed below.
•

Numeric Types

•

Alphanumeric Types

•

Binary Types

•

Date time

•

Other Variable types

Numeric Types:
Numeric data types are used for describing numeric values for the ﬁeld used in the table of a
database. Numeric data types in a database can be using for storing information such as mobile
number, roll number, door number, year of school admission, true or false statements, statistical
values, etc. The different types of numeric data types available are listed here.
Name

Data type

Description

BOOLEAN

Yes / No

Values as 0 or 1. Example: True or False, Yes or No.

TINYINT

Tiny Integer

Store integer range between 0 to 255

SMALLINT

Small Integer

Store integer range between -215 to +215-1

INTEGER

Integer

Store integer range between -231 to +231-1

BIGINT

Big Integer

Range between -263 to +263-1

NUMERIC

Number

Maximum precision of e(+/-)231

DECIMAL

Decimal

Maximum precision of e(+/-)231

REAL

Real

2-1074 to (2-2-52)* 21023

FLOAT

Float

2-1074 to (2-2-52)* 21023

DOUBLE

Double

2-1074 to (2-2-52)* 21023
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Alphanumeric Types:
Name

Data type

LONGVARCHAR

Memo

CHAR

Text (ﬁx)

VARCHAR

Text

VARCHAR_IGNORE
CASE

Text

Description
Stores up to the max length or number indicated
by user. It accepts any UTF 8 Character.
Stores exactly the length speciﬁed by user. Pads
with trailing spaces for shorter strings. Accepts
any UTF 8 Character.
Stores up to the speciﬁed length. No padding
(Same as long var char)
Stores up the speciﬁed length. Comparisons are
not case sensitive but stores capitals as you type
them.

Binary Types:
Binary data types are used for storing data in binary formats. Binary data types in a database can
be using for storing photos, music ﬁles, etc. In general, ﬁles of any format can be stored using the
binary data type. The different types of binary data types available are listed here.
Name

Data type

Description

LONGVARBINARY

Image

Stores any array of bytes (images, sounds, etc.). No
validation required.

BINARY

Binary (ﬁx)

Stores any array of bytes. No validation required.

VARBINARY

Binary

Stores any array of bytes. No validation required.

Date time:
Date time data types are used for describing date and time values for the ﬁeld used in the table of
a database. Date time data types in a database can be using for storing information such as date
of birth, date of admission, date of product sale, etc. The different types of date time data types
available are listed here.
Name

Description

Format

Date

Stores month, day and year information

1/1/99 to 1/1/9999

Time

Stores hour, minute and second info

Seconds since 1/1/1970

Timestamp

Stores date and time information
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Other Data Types:
Name

Description

Other/Object

Format

Stores serialized Java objects â€“ user
application must supply serialization routines

You had used the example of an address book in the previous lesson. An address book uses only
one table. But look at a different situation. If you are a dealer selling a single type of item and
want to record details of your sales in the past month and also want the details of the client who
purchased the item ( name, address, phone, date purchased, number of items bought etc), what
would you do?. You create a table Sales with all the details:
OrderID Customer Name

Customer Address

Phone

Sale Date

#ItemsBought

000789

Sheela Arora

xxxxxxNoida

2444490

01/11/12

3

000790

Vaibhav Mittal

xxxxGhaziabad

2443358

01/11/12

4

000791

Saurabh Tayal

xxxxNew Delhi

2678945

02/11/12

12

000792

Vaibhav Mitttal

xxxxGhaziabad

2443258

02/11/12

23

000793

Prashant Singh

xxxxRohtak

6784534

02/11/12

4

000794

Shila Arora

xxxxxxNoida

2444490

03/11/12

18

000795

Vaibhav Mittal

xxxxGhazibad

2443258

03/11/12

45

Do you see a problem here? Every time you sell an item to Sheela or Vaibhav or any other
customer (client) you need to store the details again. So, what is the solution? Create one table
for client details and another for sale details. Since each record has to be unique, you can insert a
ClientID ﬁeld to uniquely identify each client in the client table. In the Sales table, you would give
a point of reference which “points” to a particular record in the Client table.
In the example here, the ﬁeld ClientID occurs once in the Client table, but since one client can
place many orders, it occurs a number of times in the Sales table. Since we cannot have an order
without a customer, we call Client the parent and Sales the child table. Related tables like these
share a common ﬁeld. You store data about people once, but refer to those people many times
in the database.
This unique ﬁeld is called the primary key (PK). A primary key is a unique value that identiﬁes
a row in a table. In our example, ClientID is the primary key in the Client table. Primary Keys are
also indexed in the database, making it faster for the database to search for a record.
The referred ﬁeld ClientID which occurs in the Sales table is called the foreign key (FK). Hence,
the foreign key identiﬁes a column or set of columns in one (referencing) table that refers to a
column or set of columns in another (referenced) table. The “one” side of a relation is always the
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Client Table

One client, three
orders for that client.

ClientID

Name

Address

Phone

0000001

Sheela Arora

xxxxxxNoida

2444490

0000002

Vaibhav Mittal

xxxxGhaziabad

2443358

0000003

Saurabh Tayal

xxxxNew Delhi

2678945

0000004

Prashant Singh

xxxxRohtak

6784534

Primary
Key
Sales Table
OrderID

ClientID

SaleDate

#ItemsBought

000789

0000001

01/11/12

3

000790

0000002

01/11/12

4

000791

0000003

02/11/12

12

000792

0000002

02/11/12

23

000793

0000004

02/11/12

4

000794

0000001

03/11/12

18

000795

0000002

03/11/12

45

Primary Key
parent, and provides the PK attributes to be copied. The “many” side of a relation is always the
child, into which the FK attributes are copied. Memorize it: one, parent, PK; many, child, FK.
Another point to remember is that the end users will/may never have direct access to the
database. They can only see what you permit them to and can select only from the options you
give them.

EXERCISE
Perform the following activities till you are conﬁdent:
S.No.
1.

Activities
Create a database for a stationery shop.
Hint : Create ﬁelds for items, price, color, vendor, etc.
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ASSESSMENT
Short Answer Questions
1.

List the data types used in a DBMS /RDBMS?

2.

State the relationship and difference between a primary and foreign key?

3.

List datatypes available in Numeric Datatype.

4.

List datatypes available in Alphaumeric Datatype.

5.

List datatypes available in Numeric Datatype.

6.

List datatypes available in Data Datatype.

Fill in the blanks:
1.

A
is a set of data elements that is organized using a model of vertical columns
and horizontal rows.

2.

A
table.

3.

A

4.

is a set of data values of a particular simple type, one for each row of the
represents a single, data item in a table.
are used to identify which type of data we are going to store in the

database.
5.

A

is a unique value that identiﬁes a row in a table.

SESSION 3: MANIPULATING DATA
Relevant Knowledge
In a database you can deﬁne the structure of the data and manipulate the data using some
commands. There are two types of languages for this task. These are:
•

Data Deﬁnition Language (DDL)

•

Data Manipulation Language (DML)

Data Deﬁnition Language (DDL)
A data deﬁnition language or data description language (DDL) is a standard for commands that
deﬁne the different structures in a database. DDL statements create, modify, and remove database

248

Information Technology

UNIT-7

objects such as tables, indexes, and users. Common DDL statements are CREATE, ALTER, and
DROP.

Data Manipulation Language (DML)
A data manipulation language (DML) is a language that enables users to access and manipulate
data in a database. The goal is to provide efﬁcient human interaction with the system. Data
manipulation involves:
•

Retrieval of information from the database- SELECT statement

•

Insertion of new information into the database - INSERT statement

•

Deletion of information in the database - DELETE statement

•

Modiﬁcation of information in the database - UPDATE statement

A query language is a part of DML involving information retrieval only. The terms DML and query
language are often used synonymously.
A popular data manipulation language is Structured Query Language (SQL). This is used to retrieve
and manipulate data in a relational database. Other forms of DML are those used by IMS/DLI,
CODASYL databases, such as IDMS and others. Data manipulation language comprises the SQL
data change statements, which modify stored data but not the schema or database objects.
There are two types of DML:
•

Procedural: The user speciﬁes what data is needed and how to get it

•

Nonprocedural: The user only speciﬁes what data is needed. This is easier for the user but
may not generate code as efﬁcient as that produced by procedural languages.

ASSESSMENT
Fill in the blanks:
1.

Types of languages used for creating and manipulating the data in the Database are
&
.

2.

A
a database.

3.

A
database.

4.

A

5.

A popular data manipulation language is

6.

Common DDL statements are

Information Technology

is a standard for commands that deﬁne the different structures in
is a language that enables users to access and manipulate data in a
is a part of DML involving information retrieval only.
.
,

and

.
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SESSION 4: CREATING A DATABASE OBJECT
Relevant Knowledge
There are a variety of DBMS/RDBMS available; in this exercise, you will learn about OpenOfﬁce
Base an Open Source RDBMS.

Launching Openofﬁce
•

To launch OpenOfﬁce, click Start>Programs>OpenOfﬁce.org 3.4.1>OpenOfﬁce.org.
Alternatively, you can also double-click on the OpenOfﬁce.org 3.4.1 shortcut on the desktop
if available. You should see a Window similar to the one displayed below

Figure 1

Select the option database to launch the base application.
You can also directly launch the OpenOfﬁce Base Application by doing the following:
•

250

Click Start>Programs>OpenOfﬁce.org 3.4.1>OpenOfﬁce.org Base. You should are
guided through the Database Wizard for creating a database. You will see a dialog box
similar to the one displayed below.
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Figure 2

You can create a new database by selecting the option Create a new database.
You can also open an existing database ﬁle that you have already created by selecting the option
Open an existing database ﬁle.
Click Next. A dialog box similar to the one displayed below appears.

Figure 3

Click Finish. The Save As dialog box appears as shown below.
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Figure 4

Specify a name for the database in the File name: ﬁeld and click Save. A window similar to the
one displayed below.

Figure 5

Now that you have created a database, you can work with the database as outlined in the next
few sessions.
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EXERCISE
Perform the following activities till you are conﬁdent:
S.No.
1.

Activities
Create a database

ASSESSMENT
Short Answer Questions:
1.

What is the ﬁle extension for databases created using OpenOfﬁce.Org Base?

2.

List any three ﬁle formats that can be managed using OpenOfﬁce.Org Base?

SESSION 5: CREATING A TABLE
Relevant Knowledge
Tables are the basic building blocks of a database. You store the data in the database in the
form of tables. In the previous exercise you have learnt how to create database objects in
OpenOfﬁce.
In this exercise you will learn how to create a table in a database.
After creating the database, you see a window as shown below.

Figure 6
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Click on Create Table in Design View… option available under Tasks and a Table Design
window appears as shown below.

Figure 7

Specify the ﬁeld name and data type of the ﬁeld to be created by selecting the appropriate type
available under Field type dropdown list.
Now create a table with the following ﬁelds displayed below:
Specify the ﬁeld name and the data type for each ﬁeld name. For example, the table contains
Name ﬁeld and the data type of the Name is TEXT [VARCHAR]. You can specify the length of the
ﬁeld value.
Field Name

Data type

Length

Name

VARCHAR

50

Rollno

TINYINT

3

DOB

Date

DD/MM/YY

Class

Char

1

Phone

INTEGER

10

Email

VARCHAR

75

Color

VARCHAR

15

Location

VARCHAR

30

After specifying the ﬁeld name and data type for the ﬁeld variables, save the table by clicking on
File>Save shown below.
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Figure 8

Specify the table name. The default name is Table1. Click OK.

Figure 9

A dialog box appears, similar to the one displayed below.

Figure 10

You are asked to set a primary key for the table you just created. You can select the appropriate
option to set the primary key or leave the table without a primary key.
If you click Yes, the application will set the primary key for the ﬁrst ﬁeld created automatically. If
you click No, you should see a window similar to the one displayed below.

Figure 11
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Notice the table by the name SDetails created and visible under Tables section.

Create the following records:

To insert values into the table, just double-click the table name, you should see a window similar
to the one displayed below.

Figure 12

Start typing the records in the table with the data provided in the excel sheet and select File >
Savecurrent record to save data in the table.

EXERCISE
Perform the following activities till you are conﬁdent:
S.No.

Activities

1.

Create a table and enter data in it

2.

Create a database to store your academic records using the guidelines below:

• Use your roll number as the ﬁle name for your database.
• Create ﬁelds such as subject name, required score, passing score and your
percentage.
• Set the subject name ﬁeld as the primary key.
Populate your database with your most recent exam results.
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ASSESSMENT
Fill in the blanks:
1.

2.

are the basic building blocks of a database.

To design a table, you need to select
available under Task.

in

option

SESSION 6: BUILDING FORMS
Relevant Knowledge
A form provides the user a systematic way of storing information into the database. It is an interface
in a user speciﬁed layout that lets users to view, enter, and change data directly in database
objects such as tables.
In this exercise, you will learn to create a form.
To create a form, Click on Forms option located under Database section (Figure below).

Figure 13

Click Use Wizard to Create Form… option under Tasks group. The Form Wizard dialog box
appears as shown below.
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Figure 14

You can select selective ﬁelds to be sent onto the form by selecting the ﬁeld name and clicking >
button. You can select individual ﬁelds in a database or all ﬁelds in a database.
To use all the ﬁelds in the table in a form, click the >> button.
Notice the ﬁelds displayed under Fields in the forms section (Figure below).

Figure 15

Click Next>. You see the Set up a sub form step dialog box of the wizard as shown below.

Figure 16
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You can select the option Add Subform if you need to insert the contents in the table in a separate
form. Click Next>.

Now you need to arrange selected ﬁelds in a form. You can use different styles from the list
displayed below:

Figure 17

Once you have selected a style, click Next >
A dialog box appears wherein you can select the data entry model.

Figure 18

Click Next >. You should see a dialog box wherein you can specify the styles to be used in the
form.

Figure 19

Information Technology

259

UNIT-7

Click Next >. You see a dialog box where you can specify the name of the form. Click Finish.

Figure 20

A form window appears. Notice that the records in the table are displayed automatically within the
form that you just created.

Figure 21

You can add new records to the table using the form by clicking the
bottom as shown below.

symbol located at the

Figure 22

Once you click the
below).
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symbol, you will be displayed with a window for creating records (Figure
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Figure 23

You have learnt to create records using design view in the earlier sessions. You can add records
using the form as displayed below. Type the following data in the textbox provided in the box as
shown below:
Name

Gautam

Rollno

43

DOB

10/12/99

Class

X

Phone

325476

Color

Pink

Email

gautam43@gmail.com

Location

Assam

To view the saved records, Double-click SDetails (Table name) under Tables section. A window
similar to the one below will be displayed; notice the record that you created using a form is also
displayed along with other records (Figure below)
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Figure 24

Now enter three more records using the form and view them using the above mentioned
procedure.

EXERCISE
Perform the following activities till you are conﬁdent:
S.No.

Activities

1.

Create a form

2.

Enter data in a table using a form

3.

Create a form for the academic database created in the earlier session. Populate the
academic database with mark results using the form.

ASSESSMENT
Fill in the blanks:
1.

A

2.

A
as tables.

3.

To create a form you need to select
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helps the user to systematically store information in the database.
enables users to view, enter, and change data directly in database objects such

option available under Database section.
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SESSION 7: CREATE AND MANAGE QUERIES
Relevant Knowledge
Having created the tables and entering data into them, now you want to extract some information.
That’s when you query the database. As the name suggests, query is to collect speciﬁc information
from the pool of data. A query helps us join information from different tables and ﬁlter that
information. Filtering means that the query uses criteria you provide it to hide some data and
present only what you want to see.
Some RDBMS provide a graphical means to create queries, but most RDBMS do not do so. That’s
where you use SQL (pronounced as “sequel”) or Structured Query Language. Query languages
are computer languages used to make queries into databases and information systems. Queries
are commands that are used to deﬁne the data structure and also to manipulate the data in the
database.
A SELECT statement retrieves zero or more rows from one or more database tables or database
views. In most applications, SELECT is the most commonly used Data Manipulation Language
(DML) command.
The SELECT statement has many optional clauses:
•

WHERE speciﬁes which rows to retrieve.

•

ORDER BY speciﬁes an order in which to return the rows.

To retrieve all the columns in a table the syntax is:SELECT * FROM <TABLENAME>;
In order to execute queries click on the Queries option available on the left side under database
section, click Create Query in SQL View as shown below.

Figure 25

A window appears similar to the one displayed below.
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Figure 26

You can type the query in the above window and execute it by using the F5 function key or by
clicking the
icon in the window.
For example, if you want to display all the data in the table that you created in the early session,
then the select statement will be: select * from SDetails;
After executing the select query the output will be shown similar to the one displayed below.

Figure 27

To get details about the list of students whose favorite color is blue, you can use:
select * from SDetails where Color=’Blue’;
After executing the select query the output will be shown similar to the one displayed below.

Figure 28
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To view records in ascending order of RollNo, from the table the select statement will be:
select * from SDetails order by “Rollno” ASC;

Figure 29

You can add, modify or delete records using the Insert, Update and Delete commands.
To type and execute SQL commands, click on Tools > SQL. A window similar to the one below
will be displayed.

Figure 30

You can type the SQL Commands in the Command to execute space and click on Execute.

INSERT statement
INSERT statement is used to add one or more records to a database. The general syntax of the
insert statement is shown below.
INSERT INTO <table_name><column1, column2, column3...> VALUES <value1, value2,
value3 ...>;
To add a record in the database created earlier, type the following and click Execute.
insert into SDetails (“ID”, “Name”, “Rollno”, “DOB”, “Class”, “Phone”, “Email”, “Color”, “Location”)
values (‘8’, ‘Ranjith Singh’, ’67’, ‘12-03-99’,’X’, ‘435363’, ‘ranjth99@gmail.com’, ‘White’, ‘Bihar’);
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After inserting the data into the table, use select query to view the updated table. After execution
you should see a window similar to the one displayed below.

Figure 31

UPDATE statement
Update statement is used for modifying records in a database. The general syntax of the update
statement is as follows:
UPDATE <table_name> SET <column_name> = value [, column_name = value ...] [WHERE
<condition>]

To update a record using update statement, type the following and click Execute.
update SDetails set Location = ‘Bhubaneswar’ where Rollno = 14;
Execute select query to view the updated table. After execution you should see a window similar
to the one displayed below.

Figure 32

DELETE statement
Delete Statement is used to remove one or more records in a database. The general syntax of the
delete statement is as follows:
DELETE FROM <table_name> [WHERE] <condition>;
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To delete one of the records in the table created earlier using delete statement, type the following
and click Execute:
delete from SDetails where ID=8;
Execute select query to view the updated table. After execution you should see a window similar
to the one displayed below.

Figure 33

Notice the record with the Roll No 8 is deleted from the database.

CREATE Statement
Create statement is used for creating a database or a table in any RDBMS Software. A commonly
used CREATE command is the CREATE TABLE command. The general syntax of the create
statement is shown below.
CREATE TABLE <TABLENAME> ([column deﬁnitions]) [table parameters]
Column deﬁnitions: A comma-separated list consisting of any of the following
Column deﬁnition: [column name] [data type] {NULL | NOT NULL} {column options}
Primary key deﬁnition: PRIMARY KEY ([comma separated column list])
For example, if you would like to create a table using the Create statement, type the following and
click Execute.
CREATE TABLE Employee (ID INTEGER, Name VARCHAR (50),
Department VARCHAR (50),
Address VARCHAR (120),
Contact_Number INTEGER);
Now create 5 records in the table and use the SQL statements to view, modify and delete them.
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EXERCISE
Perform the following activities till you are conﬁdent:
S.No.

Activities

1.

Open the academic database created in the previous sessions.

2.

Use the select query statement to query and sort on subjects marks scored was
greater than 50%.

3.

Create a database for a school library.
Hint : Create ﬁelds for book title, cost, provider, availability, etc

4.

Create a database for maintaining a song collection.
Hint : Create ﬁelds for ﬁelds such as artist, movie, year released, etc.

5.

Create a database for collecting and maintaining census data.
Hint : Create ﬁelds for ﬁelds such as First Name, Last Name, DOB, Place of birth,
Employment Status, etc.

ASSESSMENT
Fill in the blanks:
is helps to collect speciﬁc information from the pool of data in the database.

1.

A

2.

statement retrieves zero or more rows from one or more database tables or
database views.

3.

statement is used to add one or more records to a database.

4.

statement is used for modifying records in a database.

5.

statement is used to remove one or more records in a database.

6.

statement is used for creating a database or a table in any RDBMS Software.

268

Information Technology

UNIT-7

SESSION 8: DESIGN REPORTS
Relevant Knowledge
A report is used to generate the overall work outcome in a clear format. You can also create
reports in database.
Click on Reports section under Database in the OpenOfﬁce base application.
Once you select the option, you should see a window similar to the one displayed below.

Figure 34

Now we can generate the report for the table created earlier.
Click on Use Wizard to Create Report… option available under Tasks.

Once you select the Use Wizard to Create Report… option. You should see a window similar to
one displayed below.

Figure 35

You have to select all the table ﬁelds by selecting the >> button, once you click the button >> you
should see a dialog box similar to the one displayed below.
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Click Next >.

Figure 36

Once you click Next>.you should see a dialog box similar to the one displayed below.

Figure 37

You can redeﬁne the label of the ﬁelds in the reports or else you can set the default name.
Click Next >.
Once you click Next >, you should see a dialog box similar to the one displayed below.

Figure 38
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You can deﬁne grouping for the ﬁelds of the table.
Click Next >.
Once you click Next >, you should see a dialog box similar to the one displayed below.

Figure 39

You can sort the ﬁeld variables in the report by selecting the appropriate ﬁeld and sorting
method.
Click Next >.
Once you click Next >, you should see a dialog box similar to the one displayed below.

Figure 40

You can select the layout of the report by selecting the appropriate option available under the
Layout of data down list and you can also select the orientation of the report.
Click Next >.
Once you click Next >, you should see a dialog box similar to the one displayed below.
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Figure 41

You can deﬁne a name for the report or you can use the name of the table itself for the report
also.
Click Finish.
Once you click Finish you should see a window similar to the one displayed below with the
report.

Figure 42

Now create a report containing only Name, RollNo and Phone details. Use different layouts for
the report design.
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EXERCISE
Perform the following activities till you are conﬁdent:
S.No.

Activities

1.

Create a report to display data from table

2.

Open the academic database created earlier.

3.

Design a report to display your entire academic score card.

ASSESSMENT
Fill in the blanks:
1.

A

2.

To create reports you need to select

Information Technology

is used to generate the overall work outcome in a clear format.
option available under Tasks.
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